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GETTING STARTED

LAUNCH

• Starting Storyteller issimple

• Simply go to Tools > DaiMangou >Storyteller

FIRST VIEW

Oncestoryteller is launched you will see this layout. Eachof these editor windows and their functions  
will be explained startinghere.

Various Editor Windows are docked throughout the Unity Editor for quick accessasthey are key  
editors.
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THE EDITOR WINDOWS OVERVIEW
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THE WINDOWS

• Start window: Shows general version info and contains links toour external sites can communities.

• Storyteller Editor: the main interface where you will use nodes.

• Story Scenes Editor: Used for adding and deletingscenes.

• PropertiesEditor: For viewing the properties of any selected node and making changesto it.

• Link Manager Editor: Allows for specialconnection between similar nodes to be made.

• Timeline Editor: Uses for viewing and setting characterinteractions.

• Story Sample Editor. For sampling characterinteractions.

• My Story Editor: Used for detailing story, character ,sceneand environment information.

• Templates Editor: Used forgenerating and creating reusable templates.

• CharacterHistory Selector Editor: For selecting a characterevolution state to give to another  
character.

• Route SelectorEditor: Used for selecting a route to be used by atime loop.

• Settings Editor: manages various settings foryour story project.

• Object Selector Editor: For selecting audioclips.

• Find and Replace Editor” Finding and replacing cords in a scene or across multiplescenes.

• Cleanup Editor: Used to ensure that a scene is structuredcorrectly.

• Exporter Editor: For exporting your story projecta s HTML.

• Language Localization window: Used for setting upLocalized datasets.

• TextTo NodeWindow: Used to convert .txt files to storyteller nodes.



The Editor Windows

Start window

In the start window you will seebuttons linking you to our various pages where you can view tutorials,  
seeStoryteller Update info , locate this User info guide , Download storyteller and more.

Storyteller Editor

Clicking, “Create New” , will show you this window where you are able to decide what kind of project you wish 
to create. There are three main setting Voiced, Text and Storyboard. Storyboard beigna combination of Text 
And Image displays also allowing sound effects. 

Voiced : This setting means that all nodes that some nodes that you create will have a focus on voiced
dialogue, This setting can be changed in the Settings Window. You can also change individual nodes 5
to accept text asyou usethem.



Whenever you create a new story a Story asset is created.

Followed by automatically generated data folders in which storyteller may store some data  
depending on your settings.
One of the generated subfolders will store audio clips and the other willstore images used  
throughout your story, with the exception of cover images and storyboard images which  
depending on a maintained link to the source of theimage.
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Your first task is to open aproject and set the cover image. All necessary
images are already in your project. In this User Guide we will open up the Detective BotProject.

With the Detective Bot project open you will see your interface look the way it does in the image  
above. Your focus is the Storyteller Editor Canvas. The window at the bottom is the Timeline Editor 
and the one docked next to the Inspector is the PropertiesWindow.

In the main storyteller window,  you will see all available projects listed.  Detective Bot, NPCQuest and好
きじゃない. Thereare all example storyteller projects. If you are  using this guide as a tutorial, do not 
open any projects yet. You are able to open one of the three example projects by double clicking on
it. To renameany one of them ;double click on the  name. You may also gab the tab on the right side 
of the sidebar and drag it out to view a more  detailed overview of availableprojects.

By clicking the list view /grid view button you can view the projects in list or grid view

In grid view you will see project image, name and last edit date.

In list view you will see Name, Last edit date and File size.
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Youmay freely pan in the canvas by pressing the middle mousebutton while draggingor by using alt +

right click. You may freely zoom using mouse scroll wheel or trackpad.

Here you see all the node type which exist in storyteller and you can also see that the Action and  
Dialogue nodes can be displayed in two ways.

To the upper left you will see details of the current scene we are in. Storyteller projects can contain
any amount of Scenesand you use the SceneEditor to add and removescenes.
Again if you are doing this for the first time then you will likely see ared question mark imagewhere

there is a picture of a character in the image below. You may double click on the red question mark
and navigate to Storyteller > Example Story > Detective Bot Project Data> Detective Bot Image Files.
Thereyou can select aimage.
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Character: Used to represent a character and MUST start every new chain of dialogue and actions,  
you can see this in the timeline . Character nodes can be linked to other character in a different or  
same scene. Each character can have any amount of evolution states which are usable in game and  
throughout your story. Color IDs (chaining colour) can also be set for characters when you click the  
colour circle.

Thereare only nine (9) node types . Of the 9 node types you will be using six (6) frequently.  
The 9 node types are
Character, Dialogue, Action, Route, Link, End, Abstract, Media andEnvironment.

The 6 you will use most frequently are ,Character,Dialogue,Action,Route,Link,End

Dialogue: Dialogue nodes have two modes, a mode for voiceover and Text mode. In Text mode you  

can enter text into the node , set sound effect. In Voiceover mode you can do a live voiceover  

recording directly in the node. In both modes you can click the small picture icon in the upper left of  

the node to open the storyboard image area, in the storyboard image area you can click the + button  

to make the image area larger and the – button to make it smaller, you double click theimage area to  

search and select a storyboard image. Sound effect clips in your project are added by double-clicking  

on the waveform icon in the bottom center of the node and selecting from a sound effect in the  

ObjectSelector.

Action: action nodes also have astoryboard imageareasystemand allow for sound effectsclips to be  

used.Action nodes are used to represent an action via text or sound effect.
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Route: Nodes are used to create branches in dialogue. Route nodes can be linked to other route  
nodes and even linked to route nodes in other scenes.What this means is that any change in abranch  
of dialogue can change the story of your entire project if you choose. This makes Route node perfect  
for use in gameswith multiple branches of dialogue. Route nodes can also be used to merge a 
characters branching dialogue back into one dingle chain of events by  double clicking the route icon in 
the route node to enable convergence mode

Link: On the surface , link nodes may seem simple and boring but are far more powerful. Link nodes are usually  
used to simple connect nodes at distances so that the canvas does not look messy and is easy to follow. A link  
node can become a node with an input or output (the circle things on the node. Out put on the right, input on  
the left) by simply double clicking the icon in the middle of the Link node.

However Link nodes can be used in with Route nodes to create time loop systems which you can use to move  
your story backward through time at x amount of times and then exit via route. You can use the Time loop 
Template to see this in action.

- You will need your two link nodes, one as input an one asoutput.

- The must first be connected to nodes before you can link the link nodes.

- Click the link icon on the link node with the output. Thelink manager window will now open. At this point  
you must select the correct link node to connect to. In this case we want to connect to 180_Link so we click  
the link icon next to 180_Link in the link manager. To disconnect it , click it a second time
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End:This node is used to signal the ending of achain of events and can also be used to transition to a  
new scene in Storyteller.

Abstract: This node is use only in cases where you wish to outline some information visually. This

node is not used in game, shown in the timeline nor uses time. It will only accept text.

Media: This node is used to trigger playbacks of one or more chains of events. This mode can be  
connected to any node where you wish to begin sampling playback from. Youwill se the playback in  
the timeline and Story SampleEditor.

Environment: This node is used to outline where a chain of events is taking place and can be used  
throughout a story to outline environment changes. This node only accepts text and us used as a  
guideline in active gamedevelopment to identify where environments should changeand what an  
environment shouldbe.
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Asyou see in the above imagethere are four other menus which can be expanded from the main  
context menu.

In File> you can saveyour story project, createanew project or exit the current story project.

In Display> you can toggle showing the canvas grid, showing the project info in the upper left, showing  
the nodes names above the nodes, toggling visualize story flow and showing the Tips popup on the  
canvas.

In the Storyteller canvas there are two ways of creating nodes.

- Ctrl + left click

- The Context Menu. Right Click the canvas
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To connect nodes , simply click on the output are of any node and click on the input area of  
the node you wish to connect to. To cancel a connection simply press the escape key on your  
keyboard (esc)

Storyteller warns and prevents against incorrect node connection attempts like Infinite loop  
connections as shown in the following image. An infinite lop is created when you take a node  
connectorand connect it directly to aprevious node when flows its data back in to the connecting  
node. Only time loops must be used to connect to previousnodes.
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Scenes Editor

As was mentioned. A story project can contain any amount of scenes. You can add and remove scenes  
using the ScenesEditor.
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In the scenes editor you click the blue + button to add a new scene and when you hover over a scene icon you will see a bin  
icon , if you click the bin icon the scene will be deleted, you can rename a scene by double clicking on the scene name then  
setting a new name.

You can also rearrange the scenes by dragging them around . Thus ordering your story in whatever order you want.



Properties Editor

Whenever you select anode in the canvas , you will seedetails of the selected node in the properties  
window. What you see in the properties Window depends on the type of node that you have  
selected. As shown in the two imagesbelow.
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Link Manager

The link manager is used to link together similarnodes so that they sharedata.

Character nodes, Link nodes, Route Nodes and Environment nodes are the only nodes that use the  
link manager so create specialconnections.

As shown here, the link manager is used tocreate out Link node connections

Onenode can have multiple other nodes of the sametype connected to it via the link manager.This  
means that one single node can provide its data to multiple other nodes of the same type across  
multiple scenes.

Character,Route, Link and Environment nodes use the link manager to sharedata in their own unique  
ways as is explained below.

Asyou know , link nodes connect via the Link Manager to simply allow for an invisible connection to  
other link nodes to maintain a cleanproject.

Environment nodes are connected via the Link Manager toshare data on an environment so that

environment data can be reused throughout an entirestory.
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Route nodesare connected vis the Link Manager in order to allow one master route to control the  
routes of other nodes acrossascene or multiple scenes.

Characternodes are connectedvia the Link Manager in order to allow for the linked character to have  
access to the parent characters character history and evolution states. This means that if your  
character have evolution states then your linked character can become any of there evolved  
characters.

In the example above , the character Ayumi has two evolution states, Ayumi and Ayumi 2 in her  
History and Evolution. We created a new character and linked the new character toAyumi via the link  
manager and then in the Character history editor we linked Ayumi2 to the new character so that she  
becomes Ayumi 2.

This is explained in more detain here where we talk about the My Story Editor , Historyand Evolution 
and here Character HistorySelector.
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Timeline Editor

The timeline is used to set your character interactions. Storyteller uses time to order  
interactions and each node uses time. In the properties window you will see a start time and  
a delay time. Start time indicate the precise time at which the dialogue or actionhappens and  
delay states the difference in time from the last dialogue or action

Setting these interaction is just a matter of placing one timeline node block in front of the  
other so illustrate that a block of dialogue or action happens before thenext one.

As you slide timeline node blocks around in the timeline you will see the start timeand delay  
time of the node change in the Properties Window. You may also set start time and delay  
from in the properties window or from the node directly.

For all nodes you select, you will seewhat it is connected to and what is connected to it. You  
can clock the blue link icon to disconnectnodes.

-Timeline with regular style and chaining colour visualization. This helps you to farther  
identify which character iswhich.
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You can also toggle to visibility of interactions  in the timeline by clicking the eye icons or 
completely hide character interaction from the story sample editor and timeline by turning n 
the H (hide) icon.

By pressing this icon      you care able to reveal all hidden character interactions.



You can pan across the timeline using the pan slider

Zoom in and out of the timeline by using thezoom slider

You can sample character interaction by using the Story Sample Editor after pressing the Playbutton.

Story Sample Editor

The Story Sample editor can be open by clicking the story sample editor button the timeline,  
it is next to the redstop button. You must then select the characters whose  
interaction you wish to sample. You can do this by clicking the gray circle next to the  
character name in the timeline and then clicking the refresh button in the Story Sample
editor. You can also display storyboard images with text by turning on “Show Storyboard  
Images” in the SettingsWindow.
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My StoryEditor
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The My Story Editor is where you set details about your story, characters ,environments and  
scenes. The data you set in the My Story editor will be used in the Exporter so generate your  
exported story data.

Someof the data you set in the My story editor will be used when you export your story for  
se in game aswell.

On the main page you will see sections where you can set a project cover image. Double click
the cover image area and search for a image to use as a cover image. Images will be cropped
and set.

You can select from a list of scenes , and you will be taken to the scenes tab where you willbe  
able to edit your scene information. As you add new environments they will appear here and  
linked environments will appear as oneenvironment

Select from a list of environments to edit environment data. As you create new environment  
nodes they will be added to this area. Environment nodes which are linked will appear asone

You can also select from a list of characters that exist in the story and edit that characters  
data.as you add new characters, they will appear in this area. When characters are linked the  
linked character will disappear from thisarea.



If you select a scene , you get taken to the Scenes tab where you can set a cover image forthe  
scene , detail an overview, Plot and theme of thescene.

Selecting an environment takes you to the environment tab where you can also se an environment  
cover image, environment name, Setting, Location, Physical location, Mood andHistory
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Selecting a character takes you to the character tab . This is where you can also set a  
character image by clicking the character image area once, delete a character image by  
clicking the bin icon. Set character age, name, race, sex, character type, height, backstory,  
motivation and physicalappearance.

You may also set up your characters personality by setting values for personality traits which  
fall into there categories, positive, neutral and negative personality traits. There personality  
trait values can be used in game if you sochoose.

Under the personality section you may also set voice samples for your character. You can
either double click on the waveform image to choose from an audio clip or do a live voice
recording directly in the editor by double clicking on the microphone icon.

In the far left of the My Story Editor you will see the History and Evolution Section. Click the  
blue + button to add a new character evolution state. With each new state your make give  
that character a completely an updated character bio. This allows you to add depth to your  
character and never lose track of your characters in astory.
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You open the templates editor window by going to (Open Context menu)>Windows >Templates.  

Once the window is open you will see three templates , NPC Walkup, Time Loop and VisualNovel.

So into the storyteller scenes and add a new scene. Click the scene to enter it. Then double click the
Time loop template to generate the template in the scene. Templates will only be generated in new
scenes.

Togenerateyour own templates, select a folder where you want your template to be created, then in  
the templates window you will seea list of characters that exist in the scene you arecurrently in, click  
on the characters whose nodes data you want to include in your template. Give the template aName  
in the name area and a description in the description area then click create. The template will be  
generated in the folder you have selected. Make sure that you are not currently selectin any other  
files in the project window else the template will not be created.

You may edit a template name and description by clicking the pen icon. To exit edit mode click the  
green button to go back to template creation mode.

Templates Editor
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As is described here a character evolution state can be linked to another character to make that  
chanter represent that evolutionstate.

In the example above , the character Ayumi has two evolution states, Ayumi and Ayumi 2 in her  
History and Evolution. We created a new character and linked the new character to Ayumi via the link  
managerand then in the Properties tab, we click on “History and Evolution”, the history and evolution  
window will open and show is a list of evolution states for our characterwhich we can choose from. In  
the Character History window we click Ayumi 2 to link Ayumi2 to the new character so that she  
becomes Ayumi 2.
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Character History Selector Editor



Route SelectorEditor

Now that you understand how to useTemplates, we will look at an example of setting up a time loop  
using route nodes and link nodes and the Route Selector Editor. And the Time loop template  
generated in a newscene

Selecting the node with the blue loop icon allows you to see details of the node in the
properties window.

Because this node is now a allowing for time loops , selecting the link icon in the properties window
will open the Route Selector editor. Here we select the route node which will serve as our exit point
out of the loop after we loop through time once as shown in the properties window at Loop Times.
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Thesettings window is opened by opening the context menu then going to Windows> Settings.

In the Settings window you can select from a list of microphone built in and connected to your  
machine. The microphonewhich you select will be the one use to captureyour voice recordings.

Under microphone settings you will see Media settings. You have the option of choosing for  
storyboard images to scale to fit or scale to fill the storyboard image area. You can also set a custom  
data export location, this is where your exported HTMLstory will be placed. If you choosenot to use a  
custom location then the export will be in the current stories folder.

Next you will see the Modes setting. Here you can toggle between storyboard mode and text mode.  
When storyboard mode is on, all created action and dialogue nodeswill show their storyboard areaby  
default , else if it is not on then it will not show the storyboard area.

If text mode is on, the text areawill be shown by default, else they will not show by default when  
action and dialogue nodes arecreated.

TheUseAudio Clip Length setting tells each node that has avoice clip or sound effect to use the voice

clip duration asthe duration value of the node.

Auto Time TextDialogueapproximatesduration playback of anode basedon word count , this is an  
early function of the BETA which will be removed.

Finally we have General settings. Here you can turn on or off Auto cache, this setting improves the  
ability of storyteller to backup your story project in caseof an accidental close.Setting asmaller cache  
rate further improves this but will maketo systembe abit slower.

You an also change the max zoom of the canvas so you can zoom out less or more.

And finally , in Timeline Style you can choose between Large and regular, this just allows you to adjust  
size of content in the timeline to suit you better.

Settings Editor
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Theobject selector allows you to select audio clips which exist in your unity project. Whenever you  
click on a waveform icon on a action or dialogue node , the Object selector will open and you can  
select an audio clip.

Object Selector Editor

The Find and Replace window is opened by opening the context menu then going to Windows> Find  
& Replace. This is your standard find and replacesystemwhich will find aword and replace that word  
in your current scene or acrossall scenes
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Find and Replace Editor



The Cleanup window is opened by opening the context menu then going toWindows> Cleanup. One  
the window I open you can click any on the two icons the one with the U icon will check for unused  
noses such as the ones in the scene which have no character node feeding data to them. The other  
will check for illegal connectionsand allow you to break those connections.

ExporterEditor

Cleanup Editor

TheExporter window is opened by opening the context menu then going to Windows> Exporter.

At this point the content you see in the exporter will not be confusingto you. What you are looking at  
are all the things in your story which you can choose to export into an HTML file which you can then  
view online. Please view examples of exported HTML stories on out Unity Forum post. You can go to  
the post by clicking the Forum button in the Start window.

28



29

To add a new language. Simply click the “Add new language” button. Set a language name and a  
Country code. Hereyou will seehow to accessthis data using c#.

Text To Node

Language Editor

If you have preexisting text containing characterdialogue then you can turn that text into Storyteller  
ready nodes which can then be using ingame.
Select he text file you want to convert, Justmake sure to structureyour story/ dialogue like this.

{ } start and end adialogue  
[ ]character name

{[Tom] Hello everyone how are you doingtoday.}
{[Tom] I need to talk to you for a few minutes}

{[May] Sure, noproblem}

Choose the language that your storyis in.
click CreateCharacter

click CreateNodes.



Game Bridge: Using Your Story in Game

Gamebridge is the Productioncomponentof Storyteller and allows you to take the things you make  
in Storyteller and use them in game via GameBridge.

All the information on the following pages will walk you through getting started with using your  
storyteller data ingame, using Game Bridge , Dialogue component and Character component.
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Pushing your story to game bridge

Gamebridge is the Productioncomponentof Storyteller and allows you to take the things you make  
in Storyteller and use them in game via GameBridge.

To launch the Game Bridge Window. Open the Context Menu in Storyteller by clicking the canvas and  
go to Windows > GameBridge.

Now you want somewhere to actually put your storyteller data so that it can be used in game as a  
standalonedataset. Wewill create aSceneDataAsset. Right click inside the project window and go to  
Create > Game Bridge > SceneData. Name it whatever you want to name it.
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With you SceneDataassetselected, go to the GameBridgewindiw and you will seeall the avalible

scenes in your tory listed. Click on the Scenewhich you wish to have pushed to the SceneData asset.

Onceyou have selected the scene you want, you will see a list of all the characters that exist in the  
scene and options for what type of content to push over into the SceneData. Pushing personality  
traits is turned off by default. Sound effects , voice clips and all characters are set to be pushed by  
default. Once you have made your selection. Press the “Push To Scene Data”button

If you update your story you just click the push button and your new data will update the SceneData.
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You will then need to create a new gameObject I the unity scene and attach a Interaction Component to it  
wither by selecting it from the Game Bridge window or by adding it from the Add Components option I the 
inspector.
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Then assign your scene data to the interaction component 

All the data will be setup for you, and you are now ready to move to the next steps .

Now you select the type of interaction. Linear or Non-Linear 

Linear interactions happen between characters in a predetermined way . Example. Visual novel 
interactions.

Nom-Linear is used when there is no set interaction order between characters. Like when  interacting 
with NPC  or in cutscenes.



Now that you know how to push storyteller data into a SceneData asset and assign it to an Interaction 
component.The first thing that you need to do is to create any UI you want,you must Use TextMesh
Pro.

Youalso do not need to use any UI if your gamedoesn’t require it.

Wewill proceed assumingthat you are using UI. Wewill be looking at the Dating Simscene asour first  
reference.

Select the gameobject that has the Interactioncomponentattached to it and look at the
inspector.  Make sure thatyour Storyteller canvas is also in view.

If you are not in the Dating Sim scene. Righr click on the canvas and go to File> Exit.
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Then double click on Dating Sim project to pen it.



You can now assign your UI , you can choose to disabe use of any UI component pr pression the 

powerbutton. You can use UI fpr Name and dialogue display, forward button and route buttons. You

must assignaUIprefab button to the Useroute button area. The “Route Parent” object  area is for the 

gameobject which will be the parent of the route buttons which are instanced in a grid  form. (please

look at the examplescene to see the setup in detail)

If there is aUI type that you do not need to use then you can click the green power button to turn any  
UI off.

It will be helpful to you to scroll to the bottom of the inspector and turn on “Show Help Messages”
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In the Text DisplayMode settings , you can choose to have your text be typed out at aspecific rate or  
instantly displayed.



Keyword Filters allow you to change text in dialogue at runtime, allowing you to replace :  
static keyword with dynamicreplacement
static keyword with statickeyword
dynamic keyword with static keyword  
dynamic keyword with dynamickeyword

Your keyword filters can of course use htmlmarkup <b> <color=> etc

Under the Keyword filters settings you will see option for Using voiceover and using sound effects.  
Youcan turn them on to work generallyacrossall nodes in game or turn them off and have specific  
nodes play audio.

Both can be set to automatically start, this is best left tuned on if you are not playing trough events in  
succession
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Depending on the type of node that you select, the data you see in the inspector will change. This  
part of the workflow is partially visual scripting to allow for you to give every node its own function in  
game. The data you edit in the inspector does not change your Story data, only your SceneData is  
changed.

Thenext step is to identify which character in your story is your player, select your player in your  
storyteller canvas and scroll down in the inspector and click the “Is Not Player, Turn On Player”  
button. You should only have oneplayer.

37

In this example the language is set to Japanese. To toggle between languages right click o the canvas 
and go to Windows> languages and then select the language you want to have displayed. 



When you select aDialoguenode you will see that you have the option of turning on the Markup Edit  
and accessing the Markup Editor. So <b>you</b> <color = red>can</color><i> do things </i> <size =  

20>like this</size>.

You can do things like this

If your node has avoice clip or asound effect then you will see them displayed in the voice clip and  
sound effectsection.

Currently the only overrides for the voice and sound effect are to not use the audio , however you can
still replace the audio clips and asusual the data in the actual node in the storyteller canvas will not be
lost.

38



Youwill see the Start time, Duration and Delay times of the selected node. Realtime delay is  
generated at runtime and the time between the current event and a future event. It is the  
recommended time value that you use in Conditions, which are explained next.

Conditions are the most important functions when working with the Interaction component.
They are able to trigger any function and are responsible for the triggering and processing of
many internal events necessary for interactions in game. Conditions can be made to handle
complex conditions by adding new if statementsto a condition set
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Theexecution order of conditions are from first to last.

You can set a condition to Automatically start orstart based on time. The time you use depends of

what you wish to achieve

Youcan useconditions to turn on other conditions,or stop conditions that are already running
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You can add and remove a condition by clicking the + or –button.

When you add acondition , it is placed directly under condition whose +button you clicked

Each condition can use any amount of UnityEvents, these unity events can can be triggered through a  

variety of ways.

You can move conditions up are down by clicking the up and downarrow



When we select a route node, we will see an option in the inspector for using Alternate Route Titles.  

Route Titles are just the names that will be displayed as choices that your character will make if you  

choose to use UI and displayoptions.

You can now run the example scene or continue exploring settings. This covers the use of the 

Interaction component in Linear mode.
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Open the NPC Quest Story.

In this scene the interaction component is setup the exact same way. Except it set to Non-

linear mode
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There are also 5 NPC characters in the scene, so we add a Interactable Character 

component                      to each of them.



The character that you wish to be made into your main character (Player) you add the Collision 

Interaction Trigger component to IF you are interacting with NPC’s via collision trigger. 

On your  NPC collider gameobjectyou must then add a Collision InteractionReceiver 
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You will then input the name  of the tag on your NPCs collider



Lookingat the Player character in the story, and generally based on you designing your story/dialogue  

you know who is your main characterand how your story flows. In the caseof the NPCQueststory.

We see that we have a Route node named Path Check and then four other nodes attached to it.All  

leading todialogue with other characters.
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Since you now understand how conditions work and how route nodes are used,you will understand

the next steps we will take.

The “ Path Check” route will be setup so that whichever character(NPC)we choose to speak to, a  

condition will trigger a conversation with thatNPC .

As you notice, Path check is linked to NPC1, NPC2 , NPC3, and NPC5 dialogue but is not linked to  

NPC4 dialogue. This is because NPC4 is a background character in this scene, designed to show that  

you can speak to any character even if you do not plan any dialogue with that character and also that  

NPC4is able to jump into a conversationat any point , kind of the way areal person would in real life.



All the nodes that the “ Path Check” route correspondto aRoute value.

Route0

Route1

Route2

Route3
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Set the “Route Number” of eachcharactercomponent to match the route value which the NPC  

dialogue data ison.

The player and NPC4 are not on any route so their Route Number must remain as0.

Set the main language for eachand then press the setup button on eachcharactercomponent

Route0

Route1

Route2

Route3



Route0

Route1

Route2

Route3

This final step concludes the process for this scene.

The Path check route node is going to use conditions to determine which NPC tobegin a conversation  

with. You may observe the condition setting in theinspector.

How this condition works is that if the player walks into the NPC trigger area the condition will set the  

UI to active and then the condition will tell the PathCheckRoute node to go to the route to execute a  

internal function named ContinueOnRoute. So if you walk into the NPC trigger on a character with a  

route value of 2 then ContinueOnRoute will put generatethe dialogue for the player and NPC2.

This concludes the walkthrough of using the Dialoguer componentand the Charactercomponent.
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Thank you very much for your support. It is very much appreciated.

If you have any questions regarding this User Guideor Storyteller , Please send an email to  
daimangou@gmail.com
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END
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